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Abstract- — This project presents a wearable electrodermal activity (EDA) sensor glove designed to monitor physiological signals 

related to human stress and health conditions. The glove integrates conducting fabric electrodes with embedded sensing modules, 

including a non- contact temperature sensor, GSR sensor, and pulse oximeter, to capture body temperature, skin conductivity, 

and heart-related parameters. An Arduino-based embedded system processes the collected signals and provides alerts through a 

buzzer while displaying measurements on an I2C LCD. The system is powered using regulated power supplies to ensure stable 

operation. By combining wearable textile technology with embedded electronics, the proposed design offers a compact and user-

friendly platform for continuous physiological monitoring, supporting applications in healthcare observation, stress analysis, 

and personal wellness tracking. 
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 I. INTRODUCTION 

 
In recent years, wearable technology has become an important 

part of modern healthcare systems due to its ability to 

continuously monitor physiological parameters in real time. 

Stress is a major factor affecting human health, leading to 

conditions such as anxiety, depression, cardiovascular diseases, 

and reduced productivity. Therefore, early detection and 

continuous monitoring of stress levels are essential for 

improving overall well-being and preventing serious health 

issues. 

 

Electrodermal Activity (EDA), also known as Galvanic Skin 

Response (GSR), is a widely used physiological signal for 

stress detection. It measures the changes in skin conductivity 

caused by sweat gland activity, which is directly controlled by 

the sympathetic nervous system. This makes EDA a reliable 

and non-invasive indicator of emotional and psychological 

states. 

 

Recent advancements in wearable devices have enabled the 

integration of multiple biosensors such as heart rate sensors, 

temperature sensors, and pulse oximeters along with EDA 

sensors. Studies show that combining multiple physiological 

signals improves the accuracy of stress detection systems 

compared to using a single parameter. 

 

Wearable gloves have emerged as an innovative platform for 

physiological monitoring due to their ability to provide better 

skin contact and user comfort. Conducting fabric electrodes can 

be easily embedded into gloves, making them more flexible and 

suitable for continuous monitoring compared to traditional 

rigid electrodes. 

 

Embedded systems such as Arduino play a vital role in 

processing sensor data and enabling real-time monitoring. 

These systems allow the integration of sensors, display units, 

and alert mechanisms into a compact and portable device. 

Based on these advancements, this project proposes a wearable 

EDA sensor glove that integrates conducting fabric electrodes 

with multiple sensors to monitor stress and health parameters. 

 

1. Objectives 

The primary objective is to develop a wearable EDA sensor 

glove capable of continuously monitoring human stress levels 

and physiological health parameters in real time. EDA is used 

as the core parameter because it reflects changes in the 

sympathetic nervous system, which directly responds to stress. 

The project integrates multiple physiological sensors such as 

temperature sensors and pulse oximeters, since combining 

signals like EDA, heart rate, and temperature provides better 

stress detection performance compared to using a single 

parameter. The system is designed in a wearable glove format 

using conducting fabric electrodes to improve comfort, 

flexibility, and signal quality, and it implements an Arduino- 
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based embedded system for real-time data acquisition, 

processing, and display. 

 

2. Problem Statement 

In today's fast-paced world, stress has become a major factor 

affecting human health, leading to serious issues such as 

cardiovascular diseases, anxiety, and reduced productivity. 

Traditional methods for stress detection, such as questionnaires 

and clinical observations, are subjective and do not provide 

continuous real-time monitoring. Although wearable devices 

are widely used for health monitoring, most existing systems 

rely on limited parameters such as heart rate, which are not 

always accurate indicators of stress. 

 

EDA is considered a reliable indicator of stress as it directly 

reflects the activity of the sympathetic nervous system. 

However, current EDA-based systems are often expensive, 

bulky, or restricted to laboratory environments, limiting their 

practical use in daily life. Existing wearable devices also face 

challenges such as poor sensor placement, motion artifacts, 

signal noise, and lack of continuous monitoring capability. 

Therefore, there is a need to develop a compact, cost-effective, 

and wearable system that can accurately monitor stress and 

physiological parameters in real time. 

 

II. LITERATURE SURVEY 

 
Y. B. Lee et al. (2006) presented a wearable glove embedded 

with EDA sensors using conducting fabric. The system 

measures skin conductance signals, including Skin 

Conductance Level (SCL) and Skin Conductance Response 

(SCR), to analyze human physiological conditions. Conducting 

fabric replaced traditional electrodes to improve comfort, and 

an embedded system was used for real-time signal acquisition 

instead of bulky computer-based systems. 

 

Lee et al. (2010) proposed a wearable glove integrating EDA 

and pulse-wave sensors for healthcare monitoring. The system 

uses conducting fabric electrodes to enhance comfort and 

flexibility, measuring skin conductivity and pulse signals for e- 

health applications. 

 

Schmidt et al. (2022) focused on stress monitoring using 

wearable devices equipped with heart rate and respiratory rate 

sensors, developing a dataset by collecting physiological 

signals during stress-inducing activities. The results indicate 

that wearable sensors can effectively detect stress variations in 

real-life conditions. 

 

Meijer et al. (2023) highlight EDA as a reliable signal for 

monitoring human stress and well-being, showing a strong 

correlation between EDA responses and emotional states, and 

concluding that EDA can be continuously measured using 

wearable devices. 

 

Zhu, Spachos, et al. (2023) investigated stress detection using 

EDA signals analyzed with machine learning. The study 

compared different classifiers and found that Support Vector 

Machine (SVM) provides high accuracy (up to 92.9%) in stress 

prediction. 

 

Schouten et al. (2023) published a scoping review of wearable 

EDA sensors for stress detection, concluding that EDA is a 

promising biomarker with reported accuracies up to 82%, while 

identifying challenges such as lack of real-time processing. 

 

Hepsiba and Vijay Anand (2018) focused on stress detection 

using a GSR sensor that measures changes in skin conductivity. 

Jebelli et al. (2019) evaluated the feasibility of using EDA 

signals from wearable devices to assess human stress in real- 

world environments. 

 

III. METHODOLOGY 
 

1. Existing System 

Existing systems for stress and physiological health monitoring 

are mainly based on traditional methods and wearable devices 

such as smartwatches, wristbands, and clinical monitoring 

equipment. These systems use physiological signals like heart 

rate, EDA, temperature, and respiration to estimate stress 

levels. Traditional stress detection methods, including 

questionnaires and clinical assessments, are subjective and 

cannot provide continuous real-time monitoring. 
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Modern wearable systems have improved monitoring by using 

sensors; however, most devices rely on limited parameters such 

as heart rate or basic EDA signals, which are not always 

sufficient for accurate stress detection. Most current wearable 

devices are wrist-based, which limits signal quality, since wrist-

based measurements are less sensitive compared to finger-

based measurements, where skin conductivity responses are 

stronger. 

 

1. Disadvantages of Existing System 

 Motion Artifacts: body movements cause disturbances in 

signals like EDA and heart rate. 

 Signal Noise and Distortion: poor contact or 

environmental interference. 

 Environmental Effects: temperature, humidity, external 

conditions. 

 Poor Sensor Placement: reduces signal quality and 

reliability. 

 Individual Variability: physiological signals vary person 

to person. 

 Confusion with Physical Activity: exercise can mimic 

stress signatures. 

 Data Quality Issues: missing data and inconsistent 

readings. 

 Lack of real-time Accuracy: many systems fail in real- 

world monitoring. 

 Calibration Issues: no universal standard for stress 

measurement. 

 

2. Proposed System 

The proposed system is a wearable EDA sensor glove designed 

to monitor human stress levels and physiological health 

parameters in real time. The system integrates conducting 

fabric electrodes, multiple biosensors, and an Arduino-based 

embedded system into a compact and portable wearable device. 

The EDA sensor is the core component, which measures 

changes in skin conductivity caused by sweat gland activity 

controlled by the sympathetic nervous system. In addition, the 

system incorporates a temperature sensor and a pulse oximeter 

to measure body temperature, heart rate, and oxygen saturation. 

The sensors continuously collect physiological signals from the 

user's body, especially from the fingers, where EDA signals are 

strongest. Signals are transmitted to the Arduino 

microcontroller, which processes the data using built-in analog- 

to-digital conversion. The processed data is displayed on an I²C 

LCD, and a buzzer alert system notifies the user when abnormal 

conditions are detected. 

 

 
Fig. 1. Prototype of the wearable EDA sensor glove. 

 

IV. HARDWARE DESCRIPTION 
 

1. Arduino UNO 

The Arduino UNO is an open-source microcontroller board 

based on the Microchip ATmega328P. The board has 14 digital 

pins, 6 analog pins, and is programmable with the Arduino IDE 

via a type B USB cable. It accepts voltages between 7 and 20 

V. The Uno uses the ATmega16U2 programmed as a USB-to- 

serial converter. 

Fig. 2. Arduino UNO development board. 

 

Key specifications: Microcontroller ATmega328P; Operating 

Voltage 5 V; Input Voltage 7–20 V; Digital I/O Pins 14 (6 

PWM); Analog Input Pins 6; Flash Memory 32 KB; SRAM 2 

KB; EEPROM 1 KB; Clock Speed 16 MHz. 

Specialized pin functions include Serial/UART (pins 0, 1), 

external interrupts (pins 2, 3), PWM (3, 5, 6, 9, 10, 11), SPI 

(10–13), and I²C (A4/SDA, A5/SCL). 

 

2. Power Supply 

The 7812 and 7805 voltage regulators provide stable DC 

outputs of +12 V and +5 V, respectively, from a higher input 

voltage source. The 7812 typically requires 14–16 V input; the 

7805 requires 7–25 V input. 
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Fig. 3. Regulated power supply PCB (7812/7805). 

Decoupling capacitors are crucial: a 1000 µF / 25 V capacitor 

is placed on the input side, while a 10 µF / 63 V capacitor is 

placed on the output side to filter noise. Both regulators can 

generate heat, so adequate heat sinking may be required. 

 

3. Galvanic Skin Response (GSR) Sensor 

A GSR sensor measures the electrical conductance of the skin, 

which fluctuates with moisture level linked to sweat gland 

activity. Emotional states such as stress trigger the sympathetic 

nervous system, causing sweat glands to become more active. 

The sensor measures conductance through two electrodes 

placed on the skin, usually on the fingers or palm. 

 

The typical GSR setup consists of electrodes (often silver), an 

amplifier circuit, and an interface for data processing. Two 

types of measurements are observed: tonic conductance 

(baseline, slow-varying) and phasic conductance (Skin 

Conductance Responses, rapid changes in response to stimuli). 

The GSR sensor requires 5 V and data is acquired in the 1–10 

Hz range. 

 

 
Fig. 4. GSR sensor interfaced with Arduino UNO. 

 

Table 1: GSR Sensor to Arduino Uno Connections 

GSR Sensor Arduino UNO Board 

VCC 5V 

GND GND 

SIG A0 

 

A sample Arduino sketch reads the analog value from A0 and 

converts it to voltage: 

const int GSR = A0; int sensorValue; 

void setup() { Serial.begin(9600); } void loop() { 

sensorValue = analogRead(GSR); float v = 

sensorValue*(5.0/1023.0); Serial.println(sensorValue); 

delay(100); 

serial format, requiring only four connections: VCC, GND, 

SDA, and SCL. 

} 

 

4. MLX90614 Temperature Sensor 

The MLX90614 is a contactless infrared digital temperature 

sensor that measures object temperature from −70 °C to 382.2 

°C using the I²C protocol. Key specifications: Operating 

Voltage 3.6–5 V; Supply Current 1.5 mA; Accuracy 0.02 °C; 

Field of View 80°; measurement distance 2–5 cm. 

Fig. 5. MLX90614 contactless IR temperature sensor module. 

 

The sensor consists of an MLX81101 IR thermopile detector 

and an MLX90302 conditioning ASSP with a 17-bit ADC that 

converts the signal to digital and communicates via I²C. The 

sensor is factory-calibrated. 

 

 

Fig. 6. MLX90614 interfacing schematic. 

 

5. I²C LCD Display 

I²C LCD displays interface with microcontrollers using 

minimal wiring. The 16×2 variant displays up to 32 characters; 

the 20×4 variant displays up to 80 characters. An I²C controller 
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module (typically PCF8574-based) converts parallel data to 

serial format, requiring only four connections: VCC, GND, 

SDA, and SCL. 

 

 
Fig. 7. I²C LCD 16×2 module with PCF8574 adapter 

 

 
Fig. 8. I²C LCD 20×4 module. 

 

6. MAX30102 Pulse Oximeter and Heart Rate Sensor 

The MAX30102 is an I²C-based integrated pulse oximeter and 

heart rate sensor that combines two LEDs (RED at 660 nm and 

IR at 880 nm), a photodetector, and low-noise analog signal 

processing to detect SpO2 and heart rate. 

 

 
Fig. 9. MAX30102 module showing RED/IR LEDs and 

photodetector. 

 

The chip requires 1.8 V for the IC and 3.3 V for the LEDs, 

supplied by onboard regulators. Power consumption is under 

600 µA during measurement and 0.7 µA in standby, ideal for 

battery-powered wearables. 

 

 
Fig. 10. Onboard 1.8 V and 3.3 V LDO regulators on the 

MAX30102 module. 

 

 
Fig. 11. Logic-level selection jumper on the MAX30102 

module. 

 

The module has an on-chip temperature sensor (−40 °C to 

+85 °C, ±1 °C) for calibration, a 32-sample FIFO buffer, and 

an open-drain INT pin. Communication uses I²C addresses 

0xAE (write) and 0xAF (read). 

Working Principle 
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The MAX30102 works by shining both LEDs onto the finger 

and measuring reflected light with a photodetector — a method 

called photoplethysmography. 

 

 
 

Fig. 12. Photoplethysmography: RED and IR LEDs illuminate 

the finger and the photodetector captures reflected light. 

 

Oxygenated hemoglobin (HbO2) in arterial blood absorbs IR 

light. As blood is pumped with each heartbeat, the reflected 

light changes, producing a pulse waveform at the photodetector 

output. 

 

 
Fig. 13. Pulse waveform produced as hemoglobin flow 

changes the reflected IR intensity. 

 

Pulse oximetry is based on the principle that deoxygenated 

blood absorbs more RED light while oxygenated blood absorbs 

more IR light. By measuring the ratio of reflected IR and RED 

light, SpO2 is calculated. 

 

 

 
 

Fig. 14. Absorption spectra of oxygenated (HbO2) and 

deoxygenated (Hb) hemoglobin. 

 

Module Pinout and Wiring 

 
Fig. 15. MAX30102 module pinout diagram. 

 

VIN is the power pin (3.3 V or 5 V), SCL and SDA are the I²C 

clock and data lines, INT is the interrupt output, IRD and RD 

drive the IR and RED LEDs, and GND is ground. 

 

 
Fig. 16. Wiring the MAX30102 module to the Arduino UNO. 
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Buzzer 

A buzzer provides audible feedback, alerts, or warnings. In this 

project, an active magnetic buzzer is used: its positive leg 

connects to a digital output pin (e.g., pin 9) and the negative leg 

to GND. 

 

 
Fig. 17. Active magnetic buzzer component 

 

 
Fig. 18. Buzzer connected to the Arduino UNO. 

 

V. SOFTWARE DESCRIPTION 
 

1. Arduino IDE 

The Arduino Integrated Development Environment (IDE) is a 

cross-platform Java application used to write and upload 

programs to Arduino boards. Programs are called sketches 

(.ino) and contain two required functions: setup() and loop(). 

 

 
Fig. 19. Arduino IDE with a blank sketch template. 

Libraries provide extra functionality and can be imported via 

Sketch > Include Library > Manage Libraries. 

 

 
Fig. 20. Accessing the Arduino IDE Library Manager. 

 

 
Fig. 21. Library Manager window. 

 

To enable heart rate and SpO2 functionality, the MAX3010x 

library by Daniel Wiese is installed from the Library Manager. 

 

 
Fig. 22. Installed MAX3010x Sensor Library. 

 

After connecting the board, select Tools > Board (Arduino 

UNO or Mega 2560) and Tools > Port, then use the Verify and 

Upload buttons to compile and flash the sketch. 
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VI. RESULTS AND DISCUSSION 

 

1. Results 

The wearable EDA sensor glove successfully monitored skin 

conductivity, temperature, heart rate, and oxygen levels in real 

time. The system provided continuous data, clear LCD output, 

and effective buzzer alerts during abnormal conditions. Results 

confirmed that EDA increases under stress, making it a reliable 

indicator, especially when combined with other signals for 

improved accuracy. The glove design enhanced signal quality 

and user comfort. Although minor variations occurred due to 

motion and environment, the system proved to be effective and 

suitable for real-time health and stress monitoring. 

 

2. Discussion 

The proposed wearable EDA sensor glove demonstrates that 

electrodermal activity is a reliable indicator of stress, especially 

when combined with other physiological parameters. The 

multi-sensor approach improves overall accuracy and reduces 

false interpretations, while the glove-based design captures 

stronger EDA responses from the fingers. However, the system 

is affected by factors such as motion artifacts, environmental 

conditions, and individual differences, which can impact 

accuracy. 

 

Advantages and Applications 

Advantages 

 Real-time monitoring: continuous monitoring of stress and 

health parameters. 

 Non-invasive: measures physiological signals without 

pain. 

 Accurate stress detection: EDA reflects nervous-system 

activity directly. 

 Multi-parameter measurement: combines EDA, 

temperature, heart rate. 

 Wearable and portable: glove-based, easy to wear for daily 

use. 

 Improved signal quality: finger-based sensing gives 

stronger signals. 

 Comfortable: conducting fabric electrodes are flexible. 

 Low power consumption: suitable for battery operation. 

 User-friendly interface: LCD and buzzer alerts. 

 Cost-effective: uses inexpensive Arduino-based 

components. 

 

Applications 

 Healthcare monitoring: continuous monitoring of patient 

health. 

 Stress management: identifying and managing stress using 

EDA. 

 Mental health assessment: detecting anxiety and emotional 

imbalance. 

 Fitness and wellness tracking: monitoring during exercise. 

 Remote patient monitoring: IoT-based healthcare. 

 Biofeedback systems: feedback for relaxation techniques. 

 Workplace stress monitoring: employee wellbeing. 

 Sports performance: monitoring stress and fatigue in 

athletes. 

 Rehabilitation and therapy: supporting recovery programs. 

 Military and safety: monitoring soldiers, drivers, high- risk 

workers. 

 

V. CONCLUSIONS 
 

In this project, a wearable electrodermal activity (EDA) sensor 

glove was successfully designed and developed for real-time 

monitoring of stress and physiological health parameters. The 

system integrates EDA, temperature, and pulse oximeter 

sensors with an Arduino-based embedded system to provide a 

compact and efficient solution for continuous health 

monitoring. 

 

The results confirm that EDA is a reliable indicator of stress, as 

it reflects the activity of the sympathetic nervous system. The 

integration of multiple sensors improves the accuracy and 

reliability of stress detection. The glove-based design using 

conducting fabric electrodes provides better comfort and signal 

acquisition than traditional wearable devices. Although motion 

artifacts, environmental effects, and individual variability 

remain common challenges, the proposed system demonstrates 

a low-cost, portable, and effective solution with strong potential 

for healthcare, fitness, and personal wellness applications. 

 

Output 

 
 



 

 

 

© 2026 IJSRET 
9 
 

 

 

International Journal of Scientific Research & Engineering Trends                                                                                                         
Volume 12, Issue 2, Mar-Apr-2026, ISSN (Online): 2395-566X 

 

 
REFERENCES 

 

1. Y. B. Lee, S. W. Yoon, C. K. Lee, and M. H. Lee, "Wearable 

EDA sensor gloves using conducting fabric and embedded 

system," in Proc. Int. Conf. Biomedical Engineering, 2006. 

2. Y. Lee, B. Lee, and M. Lee, "Wearable sensor glove based 

on conducting fabric using electrodermal activity and 

pulse-wave sensors for e-health application," Telemedicine 

and e-Health, vol. 16, no. 2, pp. 209–217, 2010. 

3. A. Schmidt et al., "Stress monitoring using wearable 

sensors: A pilot study and stress-predict dataset," Sensors, 

vol. 22, 2022. 

4. A. L. Meijer, L. P. A. Arts, R. Gomez, and E. L. van den 

Broek, "Electrodermal activity: A continuous monitor of 

well-being," IEEE Sensors J., 2023. 

5. L. Zhu, P. Spachos et al., "Stress detection through wrist-

based electrodermal activity monitoring and machine 

learning," IEEE J. Biomed. Health Inform., 2023. 

6. G. Schouten, E. J. M. Wouters, and M. W. H. Peeters, 

"Wearables measuring electrodermal activity to assess 

perceived stress in care: A scoping review," Int. J. Med. 

Inform., 2023. 

7. D. Hepsiba and L. D. Vijay Anand, "Stress detection using 

galvanic skin response sensor in wearable systems," in 

Proc. Int. Conf. Circuits and Systems, 2018. 

8. M. J. Jebelli et al., "Feasibility analysis of electrodermal 

activity acquired from wearable sensors," J. Constr. Eng. 

Manage., 2019. 

9. S. Conti, "Electrodermal activity sensors for monitoring 

mental and physical activity," Nature Reviews Electrical 

Engineering, 2025. 

10. A. S.-R. Kim et al., "Electrodermal activity as a proxy for 

sweat rate monitoring during physical and mental 

activities," Nature Electronics, 2025. 

11. S. Santos, J. Sousa, and J. Ferreira, "Wearable 

electrodermal activity sensor for real-time stress detection 

using machine learning," in Proc. SCITEPRESS / 

BIOSTEC Conf., 2025. 

12. D. Žagar and G. Geršak, "Performance comparison of 

wired and wireless electrodermal activity sensors," 

Electronics (MDPI), 2025. 

13. P. V. Suraparaju and S. Udhayakumar, "Electrodermal 

activity as a critical modality for wearable sleep 

monitoring," medRxiv / Wearable Research, 2025. 

14. H. Y. Y. Aldosky and D. S. Bari, "Could electrodermal 

activity detect emotions soon?," J. Electr. Bioimpedance, 

2025. 

15. "Electrodermal activity and skin temperature 

characteristics related to stress and depression," J. Affect. 

Disord. Rep., Elsevier, 2025. 

16. A. "Recent trends in electrodermal activity signal 

processing and deep learning methods for emotion 

recognition," Neuroscience J., Elsevier, 2026. 

 


